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Part 1: Acoustic Legends HD 
 
Welcome 
 
Thank you for buying Vir2 Instruments' Acoustic Legends HD. In this 
collection are $40,000 of the finest acoustic guitars, sampled in 
glorious high definition 24-bit, 96kHz stereo. This broad collection of 
acoustic guitars is sampled in the finest detail in a variety of playing 
styles, including picked notes, finger picked notes, natural and 
artificial harmonics, harmonic chords, mutes, chords, release layers, 
and even fret noise sampled for each guitar.  You'll find several 
different steel string guitars, nylon strings, twelve strings, acoustic 
bass, as well as a bonus folder featuring mandolin, ukulele, and 
banjo.  Acoustic Legends HD features the world's best guitars from 
McPherson, Taylor, Gibson, Martin, and other manufacturers.  Also 
included are numerous bonus patches of special effects, doubled 
guitars, and more.  Acoustic Legends HD also features chord banks 
containing twelve different chord types in varying positions, with 
multiple velocity layers and multiple takes per layer, and with both 
up-strokes and down-strokes, making it simple to create fully 
authentic rhythm guitar parts.  Experience legendary acoustic 
guitars, sampled in gorgeous detail and now available in one 
exquisite virtual instrument. 
 
System Requirements 
 
In order to use Acoustic Legends HD, you will need a computer 
meeting or surpassing these specifications: 

 
Mac OS 10.4.x, G4 1.4gHz or higher, 512MB RAM 
 
or 
 
Windows XP SP2, 1.4gHz or higher, 512MB RAM 
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and 
 
DVD drive, 20GB of available hard drive space, and 1GB RAM for plug-in use 
 
It's worth noting that these are minimum system requirements. To 
get the most out of Acoustic Legends HD, a faster processor will be 
beneficial, and more RAM (preferably 1.5GB or more) will give you 
much better results. Acoustic Legends HD also utilizes disk 
streaming technology, which means that faster hard drives will also 
give you better performance. 
 

Installation 
 
To install Acoustic Legends HD, simply insert Disc 1 into your 
computer and run the Acoustic Legends HD installer. 
 
The installer will install three separate components of the product: 
the library (which is approximately 19GB in size, and can be placed 
anywhere on your system), the engine (Kontakt Player 2, which 
should be installed in either the Applications folder for Mac users, or 
the Program Files folder for PC users), and the authorizer (NI Service 
Center, which like the engine should also be installed in either the 
Applications folder for Mac users, or the Program Files folder for PC 
users). 
 
Important note: The installer will copy over only the sample data 
that resides on Disc 1. You must then manually copy over the 
sample data from the other discs (the NKX and NKC files) so that 
they sit alongside the NKX and NKC files that were installed by the 
factory installer. 
 
When running the installer in its default mode, it will install not only 
the standalone application of the Kontakt Player 2 engine, but also all 
plug-in versions so that you can use Acoustic Legends HD within any 
major sequencer. If you do not plan to use the plug-in versions, or 
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only need certain plug-in versions, you can use the Custom Install 
option in the installer. However, it is generally recommended to use 
the Easy Install option unless you are certain you will never use 
another version. 
 

Updating 
 
After installation, please make sure that you are fully updated to the 
most recent versions of the three components that make up the 
Acoustic Legends HD package: the library (which contains all the 
patch information and programming), the engine (which is powered 
by Kontakt Player 2), and the authorizer (Service Center). It is 
possible that any of these components may have a more recent 
version than shipped in your physical package, so you should check 
for updates to each of these three. 
 
You can do this by visiting the www.vir2.com web site and 
checking the Support area. 
 

Registration 
 
After you've installed Acoustic Legends HD, your computer will begin 
a 30-day demo period of the library. The library will work fully during 
the demo period. To permanently authorize your computer, you must 
register the software. Registration is handled by the Native 
Instruments Service Center application. If you are a Mac user, this 
will be located in your Applications folder. If you are a Windows user, 
this will be in Program Files.  
 
Launch the Native Instruments Service Center. You will be prompted 
to enter your e-mail address and password that make up your Native 
Instruments account, or will be given an option to create an Native 
Instruments account if you don't already have one. 
 

http://www.vir2.com
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Once inside the Native Instruments Service Center, it will give you a 
list of all the Native Instruments and NI-powered products on your 
hard drive and give you the option to activate them. 
 
You are allowed to install and use Acoustic Legends HD on up to 
two computers simultaneously. You can manage your two 
authorizations, and can deactivate the license for computers you no 
longer use or own, on the Native Instruments web site. 
 

A Tour of the Library 
 
There are two types of patches included in Acoustic Legends HD: 
instruments and multis. Instruments are the core of the library, and 
you'll find dozens of different instruments spread throughout several 
folders.  
 
Multis are combinations of instruments. We have provided some 
interesting combination instruments in the "Multis" folder for your 
usage. You can also create your own multis by loading two or more 
individual instruments at a time. Some of the multis are simple 
combinations of guitars, while others are unorthodox combinations 
of special effects with guitars, some panned, transposed, or with 
other programming.  
 
We'll take some time to step through all the different instrument 
folders to give you some details behind them and some performance 
tips. We have made an effort to make the entire library playable in a 
similar style with similar features, but occasionally a certain 
instrument may offer special features not available in other 
instruments. 
 
You'll find that some instruments contain abbreviations in their titles 
(such as "KSW", "QL", "VL", and so on). Check our guide to 
Abbreviations in this booklet below. 
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Chord Banks 
Six String Chords 
Twelve String Chords 
 
The Chord Banks folder is designed to help you play realistic rhythm 
guitar patterns using either a 6-string or 12-string steel-stringed 
guitar. There are two master keyswitched instruments ("Six Str 
Chords KSW" and "Twelve Str Chords KSW") and then a number of 
subsets which will be described shortly. 
 
The two master instruments operate identically and differ only in the 
type of guitar used for the recordings. They have a specific layout 
that is arranged in octaves: 
 

 
 

The lowest octave from C0-B0 contains silent keyswitch triggers. 
They tell the engine to switch chord types. When a keyswitch trigger 
is hit, no sound is made, but the next chord played will come from 
the layer triggered by the keyswitch. With a little practice, it's easy to 
reach for these keyswitches with the left hand while the right hand is 
strumming chords. The chord types available are: 
 

C0 = major 
C#0 = major, alternate inversion 
D0 = minor 
D#0 = minor, alternate inversion 
E0 = major 7 
F0 = dominant 7 
F#0 = minor 7 
G0 = sus2 
G#0 = sus4 
A0 = half diminished (min7b5) 
A#0 = diminished 7 
B0 = augmented 
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The octave from C1-B1 contains single note samples from the 
lowest octave of the guitar. 
 
The next two octaves (C2-B2 and C3-B3) feature down-strokes and 
up-strokes, respectively. Many chords contain multiple samples per 
note. Playing an alternating pattern between down- and up-strokes 
results in a simple rhythm guitar pattern. 
 
Above the chords, in the octave from C4-B4, mute strums are 
provided. A large number of varying samples were recorded by 
asking the guitarist to mute all strings with his left hand and strum 
with his right. Mute strums are often used in certain types of rhythm 
guitar playing. 
 
The highest octave from C5-B5 contains body knocks. These can be 
used for percussive effect. 
 
Some variant patches ("QL" and "VL") are also provided; see below 
for information on abbreviations to learn more about these. There are 
also folders for each guitar labeled "Diatonic"; these are simple 
patches that have mapped only the most common chords used in a 
particular key. For example, if you load the "C Diatonic" patch, only 
the following chords will play: C major, D minor, E minor, F major, G 
major, A minor, and B half diminished (or m7b5). The Diatonic 
patches do not require keyswitching because the chord types have 
already been selected for you; these patches can be a useful tool if 
you're writing in a simpler style and know that you will stay within the 
limits of simple diatonic chords. 
 
The large chord banks include a special knob in the interface not 
available elsewhere: a Capo knob. This is a "virtual" capo. When this 
is used, samples are transposed according to the fret that you place 
the capo on. Unlike a real guitar, transposition of your playing is 
taken care for you; that is, if you strike an E major chord with the 
capo at 0 (off) or at 2 (2nd fret), you will always hear a E major chord. 
However, if the Capo knob is set to the 2nd fret, then the actual 
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sample playing is a D major sample which has been transposed up 
by two half steps. The net effect is very similar to playing a real guitar 
with a capo engaged. 
 
With a combination of keyswitches, single notes, strummed chords, 
mute strums, body knocks, and the virtual capo, a wide variety of 
rhythm guitar patterns and styles can easily and realistically be 
simulated.  
 

Harmonics 
Gibson J45 Rosewood Artificial Harmonics 
Gibson J200 Harmonic Chords 
Gibson L130 Harmonics 
Hofner Nylon Harmonics 

 
The Harmonics folder contains a variety of different types of 
harmonics played by a variety of guitars. Artificial harmonics 
(designated "Art Hrm"), harmonic chords (designated "Hrm Chords"), 
natural harmonics, and nylon guitar harmonics are all included. 
 
In some cases - for example, the natural harmonics and harmonic 
chords - a real guitar is not able to physically produce chromatic 
notes. In Acoustic Legends HD, the raw sampled notes have been 
stretched to cover all notes in between the naturally available ones. 
In this way, you have the capability to play chromatically and do 
things beyond what a real acoustic guitar can do. 
 
There are a number of alternate special effects provided alongside 
the dry patches, such as chorused, flanged, tremolo, and distorted 
versions of the original. These can be useful for unorthodox effects. 
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Muted 
Gibson J45 Rosewood Muted 
Taylor 914 Muted 
Taylor 955 Twelve String Muted 
Vantage Twelve String Muted 
 
The "Muted" folder contains four very different guitars (two six-strings 
and two twelve-strings) playing muted notes, along with some 
special effects variations on them. All muted instruments employ a 
random sample selection technique for added realism: each time you 
strike a note, it will randomly choose one of four possible samples to 
play, for increased realism. 

 
Nylon String 
Hofner Nylon 
Langejan Nylon 
 
Two different nylon-stringed guitars have been sampled: a Hofner 
and a Langejan. For each guitar, three different picking positions 
were sampled: finger, nail, and thumb. While it would be uncommon 
for a real nylon guitarist to play the higher strings with a thumb, we 
have sampled and provided the full range of the guitar sampled with 
the thumb. Each of the three picking position gives a different 
character to the same guitar. 
 
There are three different ways to approach the nylon picking 
positions. First, the individual patches for finger, nail, and thumb are 
provided for individual loading. Second, the basic patches (labeled 
simply "Hofner Nylon" and "Langejan Nylon") employ a split point 
selected for you: notes below D3 are played with the thumb and 
notes above D3 are played with the finger, and no nail samples are 
used. Third, keyswitch patches are provided that load all three layers 
simultaneously and allow you to use three keyswitch triggers to 
switch between them: C0 triggers thumb samples, D0 triggers finger 
samples, and E0 triggers nail samples. A number of variant patches, 
including NR and QL patches, are also provided. 
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Steel String (Finger Picked and Picked) 
Lowden 025 Finger Picked 
Martin D35 Finger Picked 
Gibson J45 Rosewood Picked 
Gibson J200 Picked 
Martin DC1E Picked 
McPherson MG4.5 Picked 
Taylor 914 Picked 
 
Two folders of steel string guitars are provided, some finger-picked 
and some picked with a plastic pick. The finger-picked guitars are 
extremely mellow and gentle, while the plastic-picked guitars have 
more attack and percussiveness to them. A number of variant 
patches, including "NR" and "QL" patches, are also provided. 
 

Twelve String Picked 
Taylor 955 Twelve String 
Vantage Twelve String 
 
Two different twelve-string guitars are provided, each with a very 
contrasting tone. A number of variant patches, including "NR" and 
"QL" patches, are also provided. 

 
Xtra Bonus Content 
Acoustic Bass 
Banjo 
Body Knocks 88 
Fret Noise 88 
Mandolin 
Mandolin Chords 
Ukulele 
Ukulele Chords 
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As a bonus, several other acoustic stringed instruments have been 
recorded and included in Acoustic Legends HD: an acoustic bass, 
banjo, mandolin, and ukulele. The mandolin and ukulele have been 
sampled both as single notes and as chords. There are also two 
patches of guitar effects: "Body Knocks 88" and "Fret Noise 88". In 
these patches, all 88 keys of the MIDI keyboard are filled with various 
samples of that effect. 
 
The mandolin patches allow you to switch to a tremolo layer by 
moving the mod wheel to its upper half (65 to 127). "Mandolin 
Tremolo" is also available as an independent patch. 
 
Mandolin and ukulele chord instruments have been recorded with 
both major and minor chords, played with down and up strokes, 
then mapped out in a simple way: 
 

 
 

Xtra Special Effects 
 
This folder is filled with numerous unusual effects. The raw guitar 
samples are still being used, but are being warped beyond 
recognition to the point that they may sound nothing like guitars 
anymore. This is a useful folder for sound designers and other 
programmers who want to extend their sonic palette. There are 
percussive, legato, melodic, detuned, arpeggiated, and many other 
types of sounds included. 

 
These effects can be used by themselves and can also sometimes 
be combined with traditional guitar patches for interesting layers. 
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Note that due to the unusual effects used by the Xtra Special Effects 
patches, not all external controllers work with every instrument. 
 
Abbreviations 
 
Chrs: Chorus effect. 
 
Dly: Delay effect. 
 
DTune: Instruments that are artificially detuned on a random per-
note basis. 
 
Flg: Flanger effect. 
 
Gentle: Instruments labeled "gentle" use only the lower velocity 
samples of the instrument. While you can still play a "gentle" 
instrument dynamically, you'll find that there is less of a dynamic 
range than loading the full version of the same instrument. These 
instruments can be more appropriate for ballad or background 
playing in which you may not want the more aggressive samples that 
would normally be triggered by high velocities. 
 
KSW: Keyswitch patch. Keyswitches are silent key triggers that tell 
the engine to play back a different layer of sounds. For example, in a 
certain keyswitched instrument, hitting the key C0 will make no 
sound, but will tell the instrument to play only muted samples, while 
hitting the key D0 will tell the instrument to play only sustained 
samples. In the chord banks, keyswitching is used to switch 
between various types of chords. You can use the keyswitches in 
real-time to switch between various layers. In each keyswitched 
instrument, you'll see a visual indication in the interface of which layer 
is currently active, along with which keyswitch triggers it. 
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NR: No randomization. These versions of the instrument insure that 
each time you hit a certain key at a certain velocity, the exact same 
sample will be triggered. Instruments that are not labeled as NR will 
automatically use a special technique to choose a random sample 
each time a certain key is pressed at a certain velocity. In general, 
randomization creates a more realistic sound, because each time 
you play a note on a real guitar it will sound slightly different, but we 
have provided NR patches if you do not wish to utilize this feature. 
 
QL: Quickload instrument. These versions of the instrument utilize 
only a few samples which are representative of the full sample set. 
They load much faster than the full versions and use much less 
memory, but they contain much less sonic detail. They can be useful 
if you want to audition guitars (to listen to the flavor of a guitar). QL 
instruments also lack some extras, such as release layers. 
 
Trem: Tremolo effect. 
 
VL: Voice limit. Chord banks with the VL tag only allow one chord to 
sound at a time. If two chords are played at once, the second chord 
will cut off the first one. These patches are ideal for rhythmic chordal 
playing with mute strums; when using the VL patch, the mute strum 
will fully mute any currently playing chord. However, a mute strum will 
not silence single notes. 
 

Controls 
 
Each instrument in Acoustic Legends HD may contain slightly 
different controls, but most follow a similar basic layout: 
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M and S buttons allow you to mute and solo the instrument, 
respectively. 
 
Tune, pan, and volume controls are available in all instruments. 
Pan is the left control which normally stays centered; volume is the 
right control which can be swept from minimum to maximum. 
 
The top row of knobs provide specially optimized EQ controls, giving 
you access to a low shelf control, a mid gain control with a mid 
frequency sweep, and a high shelf.  
 
Chord banks contain a Capo knob in the second row, allowing you 
to "virtual capo" the guitar to achieve a different timbre. Transposition 
is taken care of automatically by the Capo knob. 
 
A basic Reverb module is provided, and controls to adjust the level 
and the reverb size are onscreen. When the level is set to 0, the 
Reverb is effectively bypassed and uses no CPU. 
 
The third row may contain a variety of controls, such as a stereo 
width control (allowing you to collapse or expand the stereo field), 
fret noise control, and release layer control. 
 
Some instruments contain keyswitch readouts, allowing you to see 
what keyswitch is currently active. 
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Consult the Kontakt Player 2 manual for more details on some of the 
other features visible, such as MIDI channel assignments, output 
selection, sample purging, and so on. 
 
Remote Controls 
 
Many parameters of Acoustic Legends HD can be controlled 
remotely via MIDI continuous controllers (CC's) sent from a controller 
keyboard. These apply to most instruments in the library, however, in 
a few cases the effect may not be noticeable (e.g. vibrato on very 
short samples like the muted guitars) or may not be relevant (e.g. the 
instruments in the Xtra Special Effects folder). 
 
CC#1 - Vibrato: In most instruments, sending CC#1 (normally the 
mod wheel) will add a touch of artificial vibrato to the guitars. 
 
CC#7 - Volume: Controls the volume of the guitar. 
 
CC#10 - Pan: Controls the pan of the guitar. At its mid position (64) 
the guitar will be perfectly centered. 
 
CC#11 - Expression:  Acts as another volume control in addition to 
CC#7. Some users prefer to use CC#11 instead of CC#7, so this 
has been programmed for that purpose. CC#11's volume acts within 
the volume set by CC#7. 
 
CC#12 - Attack: Controls the attack time of the guitar. Each guitar 
defaults to 0ms attack (CC#12=0) but you can raise this to soften the 
attack and produce a gentler sound. 
 
CC#13 - Release:  Controls the release time of the guitar. This 
refers to the amount of time after the key is released to the time the 
instrument is completely silenced. In most guitars, this is set by 
default to somewhere between 100-200ms. However, you can 
manually control release time by assigning a controller knob to 
transmit CC#13. This may be useful for harmonics patches if you 
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prefer each note to ring out to the end of the sample instead of being 
cut off when the key is released. 
 
CC#14 - Falls: In most guitars, this knob acts as an on-off switch. If 
CC#14 is in its lower half (0-64) then when each key is released, a 
very quiet release sample is triggered. This sample is the sound of 
the finger being lifted off the fretboard, and adds an additional 
degree of realism to sequenced guitar playing. (Note that you can 
control the level of the release layer via the onscreen knob within the 
instrument.) If CC#14 is turned to its upper half (65-127) then the 
release layer is silenced and is replaced with a layer of falls, which is 
the sound of the finger zooming towards the first fret. This can 
effectively be used for soloistic playing, for example, for the last note 
in a phrase. 
 

Tech Support 
 
Vir2 Instruments stands behind its products and is committed to 
helping you get the most out of using them. Please check the 
Support area of the www.vir2.com web site if you encounter any 
difficulties in using the product. You may also e-mail 
support@vir2.com. 
 
Before getting in touch with Vir2 Instruments regarding problems 
with the product, make sure you are running the latest versions of 
the library, engine, and Service Center. Many problems are rectified 
by interim updates that may have been released after the physical 
manufacturing of your installation discs. 
 

Advanced Notes 
 
Removing Parts of Acoustic Legends HD 
 
Due to the large size of the Acoustic Legends HD library, we have 
designed it in such a way that if you would like to delete a specific 

http://www.vir2.com
mailto:support@vir2.com
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part of the library from your hard drive to save space, you may do so 
manually. Please note that when the encoded sample files are 
deleted, the corresponding instrument files that rely on those 
samples can no longer be used, and will give an error if loaded. The 
removal of the encoded sample files should only be done by an 
experienced user who is sure they will not use those specific 
samples. In addition, the Xtra Special Effects folder of patches relies 
on a variety of samples from all across the entire library, so if you 
intend to explore this folder, you should not delete any of the 
encoded sample files. 
 
To remove parts of the library, locate the Acoustic Legends HD 
Library folder on your hard drive. In it, you will find numerous files 
with the .nkx and .nkc suffixes, along with an Instruments and Multis 
folder. The .nkx/.nkc files are the encoded sample files, and they are 
numbered. You may remove as many of these as you want (except 
for "002" and "Info") if you do not plan to use them and do not plan 
to use the Xtra Special Effects folder. Both the NKX and 
corresponding NKC file(s) can be removed. Here is a guide to the 
numbering to assist you in removing specific portions of the library: 
 

001: Acoustic Bass 
002: Acoustic Essentials (do NOT delete this under any 

circumstance; many patches in the library rely on this) 
003: Banjo 
004-006: Chords Six String 
007-009: Chords Twelve String 
010: Gibson J45RW Artificial Harmonics 
011: Gibson J45RW Mute 
012: Gibson J45RW Pick 
013: Gibson J200 Harmonic Chords 
014: Gibson J200 Pick 
015: Gibson L130 Harmonics 
016: Hofner Nylon 
017: Hofner Nylon Harmonics 
018: Langejan Nylon 
019: Lowden 025 Finger 
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020: Mandolin 
021: Martin D35 Finger Pick 
022: Martin DC1E Pick 
023: McPherson Pick 
024: Taylor 914 Mute 
025: Taylor 914 Pick 
026: Taylor 955 12-String 
027: Taylor 955 Mute 
028: Ukulele 
029: Vantage 12 String Mute 
030: Vantage 12 String Pick 
Info: Important library-wide information (do NOT delete this 

under any circumstance) 
 

Using Acoustic Legends HD in Kontakt 2 
 
Acoustic Legends HD ships with the Kontakt Player 2 software as its 
playback engine. Advanced users may also open Acoustic Legends 
HD in the full version of Kontakt 2 to access deeper editing features, 
or to use Acoustic Legends HD alongside libraries in other formats. 
Visit the Native Instruments web site for special offers to upgrade 
from Kontakt Player 2 to the full version of Kontakt 2. 
 

License Agreement 
 
The samples contained herein are licensed, not sold to you, the 
individual end user, by Vir2 Instruments. This non-exclusive, non-
transferable license is granted only to the individual end user who 
has purchased an unopened, new, and lawfully made copy of this 
product from a dealer or distributor authorized by Vir2 Instruments.  
All samples remain the property of Vir2 Instruments and are licensed 
only for use in the creation of a live or recorded performance that 
includes the licensed samples as part of a derivative musical work 
created by the licensed end user. This license expressly forbids 
resale, rental, loan, gift, or transfer of these samples in any format or 
via any medium, except as part of a derivative musical work. The 
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samples may not be included, whether unmodified or as part of a 
derivative work, in any sample library product. Any unlicensed usage 
will be prosecuted to the maximum extent possible under the law.  
 
Credits 
 
Produced by Vir2 Instruments. 
 
Programming by David Das, Steven Bolar, Michael Elsner, and Matt 
Haines. 
 
Special thanks to Michael Elsner, Chuck Yamek, Jamie Harvill, Dan 
Santucci, Martin Jann, Markus Krieg, Wolfgang Schneider, Nicki 
Marinic, Frank Elting, Peter and Arjen at audioease.com, Antoni 
Ozynski at pspaudioware.com, Ev and Audiofile Engineering. 
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Part 2: The Kontakt Player 2 Engine 
 

Introduction 
 
This section of the manual is designed to help you get up and 
running with the engine portion of Acoustic Legends HD. The engine 
powering the library is the Native Instruments Kontakt Player 2. 
 
Kontakt Player 2 may be used either as a standalone application or 
as a plug-in within a sequencer. We will describe the installation and 
registration process that applies to both modes, and then go into 
detail about how to use it in a variety of situations. 
 

Installation under Windows XP 
 
If this is your first Kontakt Player 2 product, then the Player will be 
installed with the library. If you already own a Kontakt Player 2 library, 
the Player installation will be skipped and the library will be installed. 
 
•Insert the Acoustic Legends HD Disc 1 into the optical drive. 
•Use the Windows Explorer to view the contents of the disk. 
•Start the installation by double-clicking Acoustic Legends HD 
Setup.exe. 
•The setup program will suggest C:\Program Files\Native 
Instruments\Kontakt Player 2 as the path for the destination folder. 
You may also choose another folder. 
 

Installed Folders, Files, and Links 
 
The setup program creates a new folder called Kontakt Player 2 in 
the installation directory (Program Files\Native Instruments). This 
folder contains the files required to operate the software. If you do 
not choose a different program path during installation, links to 
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Kontakt Player 2 and a ReadMe file are added to the Start menu 
under Programs\Native Instruments. 
 
Important: Do not move the installation folder to another location! 
 
VST, DXi, and RTAS Plug-in Installation 
 
When the choice is given by the installer, tick the correct plug-in from 
the list of components to install. 
 
For VST, you can choose to automatically search for the VST plug-in 
folder, or manually select the VST plug-in folder of your choice. 
Please select the option that best suits your installation requirements. 
 
If you decide to install the VST plug-ins at a later date, simply copy 
the "KontaktPlayer2 VST.dll" from the VST folder of the installation 
folder into the VST plug-ins folder of the host program. 
 
Note: If the VST plug-ins are not visible in the Windows Explorer, 
select the Show All Files option. This option is located in the Explorer 
menu View -> Folder Options...on the View tab below Hidden files. 
Optionally, you can set up your host programs so that they all use 
the same VST plug-ins folder. 
 

Updating 
 
Be sure to check the Native Instruments web site for any possible 
Kontakt Player 2 updates that have occurred since the time your 
software was manufactured. Software is frequently updated and a 
more recent version may be available. Library updates may be 
available at the www.vir2.com website.  Please check the Library 
Info box (Browser) for relevant links. 
 
After the library has been installed, it needs to be registered. You are 
given a 30-day grace period for each library before registration is 

http://www.vir2.com
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required, but it is recommended that you register as soon as 
possible. Information on the registration procedure is given below.  
 

Installation under Mac OS X 
 
If this is your first Kontakt Player 2 product, then the Player will be 
installed with the library. If you already own a Kontakt Player 2 library, 
the Player installation will be skipped and the library will be installed. 
 
•Insert the Acoustic Legends HD Disc 1 into the CD/DVD drive of 
your computer. 
 
•Double-click the installation program INSTALL ACOUSTIC 
LEGENDS HD to start it. 
 
•The start screen appears first. After clicking Continue and 
confirming the license agreement, a window opens where you can 
select the installation location and the destination folder.  
 

Installation Type 
 

Easy Install 
 
The easy install method installs all components of the software. This 
includes, but is not limited to, the standalone application, all plug-in 
versions, and documentation. In most cases, you will want to use the 
easy install method. 
 

Custom Install 
 
You also have the option to perform a custom installation of your 
software. This is practical in two situations: 
 
•You want to (re)install just one or more items without installing 
everything again. If this is the case, check only the necessary boxes. 
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•You know that you do not need certain items to be installed. In this 
case, leave the necessary items unchecked. 
 

Updating 
 
Be sure to check the Native Instruments web site for any possible 
Kontakt Player 2 updates that have occurred since the time your 
software was manufactured. Software is frequently updated and a 
more recent version may be available. Library updates may be 
available at the www.vir2.com website.  Please check the Library 
Info box (Browser) for relevant links. 
 
After the library has been installed, it needs to be registered. You are 
given a 30-day grace period for each library before registration is 
required, but it is recommended that you register as soon as 
possible. Information on the registration procedure is given below. 
 

Authorizing the Library 
 
After installing the library, it will run in demo mode (also called a 
grace period) for 30 days. When you launch Kontakt Player 2, in the 
Browser you will see a little caution icon to the left of the library title.  
 
Yellow means the library is running in demo mode.  
 
Red means the demo period has expired and the library can no 
longer be used until it has been registered. The red icon may also 
appear if the system ID of the computer changes due to new 
hardware components (CPU, motherboard, etc.) If this occurs, the 
library will need to be re-registered.  
 
After a library has been properly registered, the caution icon 
disappears entirely. 
 

http://www.vir2.com
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To authorize the library, you should use the Native Instruments 
Service Center application, which was installed along with the 
Kontakt Player 2 software. You can start Service Center through the 
Info box registration tab. For more information on how to use Service 
Center please see the accompanying documentation in the Service 
Center application folder. 
 

Methods of Using Kontakt Player 2 
 
There are two main ways to use Kontakt Player 2: as a standalone 
application and as a plug-in within a host sequencer. 
 

Standalone Use 
 
Standalone operation is ideal for situations in which Kontakt Player 2 
is the only audio software you need to run on the computer, for 
example, in a live performance situation in which you have all your 
patches loaded and wish to call them up for use individually. 
 
To use Kontakt Player 2 as a standalone application, go to the 
Program Files or Applications folder and launch Kontakt Player 2. 
When you do this, Kontakt Player 2 communicates directly with your 
computer's audio and MIDI hardware interfaces. 
 

Audio Setup and Soundcard settings 
 
Kontakt Player 2 works in standalone mode with ASIO, MME, and 
DirectSound drivers on the PC, and CoreAudio drivers on the 
Macintosh. For PC users, ASIO drivers are recommended because 
they usually give the best performance. You can also use 
Directsound and Multimedia (also called MME), but expect a 
significant delay (called latency) between the time you play a note 
and the time you hear it. 
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ASIO (Audio Streaming Input Output): this protocol was 
developed by Steinberg. It is highly recommended for its low latency, 
multi-channel audio card support, and high performance. 
 
DirectSound: Developed by Microsoft, this is a is a component of 
DirectX 5.0 or higher for Windows. How well DirectX works well 
depends on your sound card. If you adjust the interface for an 
acceptable amount of latency, you may hear glitches and clicks in 
the audio output that can only be fixed if you increase latency.  
 
MME (Multi Media Extension): This is the standard Windows 
audio driver. Most sound cards support this interface and work with 
it quite well. However, MME is even less suitable than DirectSound 
for real-time applications due to its comparatively high latency. 
 
Core Audio: This driver for MacOS X is integrated tightly into the 
operating system, and works with external soundcards, as well as 
the Mac's integrated audio output (known as built-in). Nowadays, 
many audio interfaces support Core Audio out of the box. They are 
simply "plug and play." Others, however, may require an additional 
driver to be installed. Please check your audio interface's 
documentation for further information. 
 
When using Kontakt Player 2 as a standalone application, the 
program communicates directly with your soundcard. Therefore, it is 
necessary to specify Audio and MIDI settings, as well as the 
preferred driver protocol.  
 
Setup for Mac and Windows machines is essentially identical, except 
where indicated. Note that if you change your soundcard, you will 
need to re-adjust these settings. 
 
Call up the Audio and MIDI Settings dialog from the Setup menu.  
 
You'll see two tabs: Soundcard and MIDI. 
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Interface: Choose the fastest driver protocol supported by your 
sound card, which will be ASIO (for PC users) or CoreAudio (for 
Macintosh users).  
 
Note for Windows users: avoid using any drivers listed as 
"emulated," as they provide poorer performance than other drivers. 
For example, although DirectSound drivers generally outperform 
MME drivers, MME drivers will outperform emulated DirectSound 
drivers. 
 
Sample rate: The drop-down menu will display compatible sample 
rates for your audio interface. 44.1kHz is the same sample rate used 
for CDs, and is the most universal choice. However, some audio 
interfaces offer 48kHz, 96kHz, and higher. These higher rates stress 
your computer more, but offer somewhat better high frequency 
response. If you are using Kontakt Player 2 in standalone mode, 
choose whichever rate you prefer.  
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Output Device: Use ASIO written specifically for your audio interface 
(not "ASIO DirectX" or "ASIO Multimedia," unless no other choices 
are available), or for the Mac, Core Audio. 
 
Output Latency: This field displays the output latency. For some 
drivers you can adjust the latency individually using a fader. If a fader 
is not present, then you need to open the ASIO Configuration by 
pressing the ASIO Config button in the Soundcard tab and adjust the 
latency using the buffer size setting in the control panel of your audio 
card. Higher buffer sizes result in higher latency and vice versa. 
However, lower buffer sizes place more strain upon the computer's 
CPU. If a computer's CPU is strained too much, you may begin to 
hear audio artifacts such as pops and clicks. Experiment with the 
latency setting until you find the best compromise between fast 
response and clean audio performance. 
 

MIDI Setup 
 

 
 
If your MIDI interface offers multiple ins and outs, you can choose 
which one(s) connect to Kontakt Player 2. When you click on the 
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MIDI tab, you'll see a list of all available MIDI inputs and outputs. 
Click on any "off" designation to turn it on. 
 
When used in standalone mode, Kontakt Player 2 supports MIDI 
input from 4 simultaneous ports, yielding a maximum of 64 
simultaneous MIDI channels. You can access this by enabling up to 
four different incoming ports in the Input Interface section. They are 
assigned in order; the first enabled port will appear in Kontakt Player 
2 as [A] 1-16, the second enabled port as [B] 1-16, and so on. 
 
The Output Interface section is used to specify where the MIDI is 
channeled to (similar to MIDI THRU ports). Typically this is not used 
for most sampling applications. 
 

Plug-in Use 
 
Used as a plug-in, Kontakt Player 2 is not a standalone program, but 
rather a "module" that can be used within a host sequencer. While 
standalone mode is often useful when Kontakt Player 2 is all you 
need, plug-in mode is more useful when sequencing, or when other 
plug-ins may be in use. For example, in a sequencing environment 
you may wish to record 16 channels of Kontakt Player 2 instruments 
then combine them with other audio or MIDI tracks and create a mix. 
Plug-in operation provides other benefits such as: 
 

•MIDI sequencing of Kontakt Player 2 and audio mixdown 
of the MIDI tracks within a single program 
•Comfortable automation of Kontakt Player 2 parameters in 
the host sequencer 
•Further processing of Kontakt Player 2 signals using 
additional plug-ins 
•Restoring of all plug-in settings when the host sequencer 
recalls a project 
•Integration with other instruments into a "virtual studio" 
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Kontakt Player 2 is available for use in VST, DXi, and RTAS formats 
on the PC, and in VST, AudioUnit (AU), and RTAS formats on the 
Macintosh. 
 
Note: Some hosts include "wrappers" that convert one plug-in 
format to another. Try each one, as one may offer better 
performance than another. 
 
VST (Virtual Studio Technology): This cross-platform plug-in 
format was developed by Steinberg, and is used by programs such 
as Steinberg Cubase, Nuendo, Native Instruments Kore, and Ableton 
Live. It is one of the most common plug-in formats, and many 
programs are optimized to work with VST plug-ins. 
 
DXi (DirectX Instrument): Based on Microsoft's DirectX 
technology, this plug-in interface for software synthesizers and 
instruments is designed for low latency and high performance on the 
Windows platform. Cakewalk Sonar and Image Line FL Studio are 
the most popular hosts to support DXi. 
 
RTAS (Real Time Audio Suite): This format was designed by 
Digidesign and is used in all current versions of Pro Tools. Unlike 
traditional TDM effects that depend on using Digidesign hardware, 
RTAS plug-ins are "native," meaning that they rely on the CPU of the 
host computer to do their computations. 
 
AU (AudioUnit): This plug-in format was developed by Apple and is 
unique to the Macintosh platform. It is the most popular Macintosh 
plug-in format, and is supported by programs such as MOTU's 
Digital Performer, Apple's Logic, Native Instruments Kore, and 
Ableton Live. 
 
When Kontakt Player 2 is used as a plug-in in any of these formats, 
it's not necessary to set up Audio/MIDI settings as described above 
for standalone use. Kontakt Player 2 operates within the host 
sequencer, automatically receiving the MIDI that the host sequencer 
sends to it, and sending back its audio output to the host sequencer. 
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Because of this, settings regarding audio and MIDI interfaces as well 
as buffer sizes (latency) are governed by the host sequencer, not by 
Kontakt Player 2. 
 
Offline Bounce Mode: If you hear crackles or drop-outs when 
bouncing / freezing tracks in hosts, please be aware that not all 
hosts correctly announce this mode to their plug-ins; when Kontakt 
Player 2 is used as a plug-in, the "Offline Bounce Mode" button in 
the Engine tab is displayed; when Kontakt receives the bounce signal 
from the host, this will automatically turn this button on; if the button 
does not turn on automatically, this means the host does not support 
this feature and you have to enable it manually (it will turn orange). 
 
 

Using Kontakt Player 2 in a Sequencer 
 
We will now describe the procedures involved in using Kontakt 
Player 2 inside each of the major host sequencers on both 
Macintosh and PC. 
 

Native Instruments Kore 
 
Launch Kore. 
 
Locate the Browser. If it is not visible, open it and select the Plug-ins 
tab.  
 
Note the View tabs labeled Instruments and Effects. Choose Kontakt 
Player 2 from the list and drag it to the rack (empty space above the 
browser).  
 
This will create a new Sound layer which includes Kontakt Player 2. 
Click on the Sound layer tab to open the interface for editing, e.g. 
add more instruments or send effects, assign controls, and thus 
begin designing your Sound layer. 
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Kontakt Player 2 now appears in the instrument slot and is ready to 
use. The instrument mixer channel will allow you to mix, pan, and 
process the software's output. 
 
If the Instrument interface is not already open, press the E button in 
the assignment panel to call up the Kontakt Player 2 interface. Here 
you can control and edit all the features and functions that the 
product has to offer. 
 
After loading an Instrument, you should be able to trigger it via MIDI 
using a keyboard controller. Kontakt Player 2's sound will generate 
through Kore and directly to your sound card. If the plug-in does not 
receive MIDI or generate audio, then make sure to check the 
following areas: 
 
Open the Setup menu>Audio MIDI settings dialog. Select the MIDI 
tab and make sure your MIDI device shows up and is ON. 
 
Check the channel's MIDI filter settings. Make sure that the MIDI 
channel is set to receive on the channel which your keyboard sends.  
 

Cubase and Nuendo 
 
Launch Cubase or Nuendo, go to the Devices menu option and 
select the VST Instruments menu option or press F11 on your 
keyboard. 
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A window showing the instrument rack appears. Click on an empty 
slot and choose Kontakt Player 2 from the available list of instrument 
plug-ins. 
 

 
 
Kontakt Player 2 will now appear in your list and automatically be 
turned on. It will also create a set of audio channels in your VST 
mixer that will be used for mix down within your project. This will 
allow you to mix, pan, and process Kontakt Player 2's output just like 
any other existing audio track in your Cubase/Nuendo song. 
 
Click on the Edit (e) button to call up the Kontakt Player 2 interface. 
Here you can control and edit all the features and functions that 
Kontakt Player 2 has to offer. 
 
Now go to the Project page and add a MIDI track (if you do not have 
one already created). 
 

 
 
In the Inspector, go to the Output parameter section for this MIDI 
Track and click on the field. This will show a list of available MIDI out 
ports to assign to this MIDI track. Choose Kontakt Player 2 from the 
list. 
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Note: If a product does not appear in the list of available VST 
instruments, then you may need to enable it manually via the 
Devices/plug-in information window. If the product does not show up 
there, then it may not be installed correctly. Please refer to the 
previous section on installing the plug-in for both Windows and Mac 
platforms for more assistance on setting this up. 
 
After having loaded Kontakt Player 2 from the library, you should be 
able to trigger it via MIDI using a keyboard controller. Kontakt Player 
2's sound will generate through the VST mixer and directly to your 
sound card. If the plug-in does not receive MIDI or generate audio, 
then make sure to check the following areas:.  
 
The MIDI channel of your MIDI track must correspond to the receive 
channel of the loaded instrument. 
 
Make sure that you have properly configured your sound card for use 
with Cubase/Nuendo. 
 
You may also want to refer to the Cubase/Nuendo manual which 
offers additional instruction in using virtual instruments and plug-ins 
within a Cubase/Nuendo project. 
 

Apple Logic Pro and Logic Express 
 
Launch Logic and create an audio instrument track or set an existing 
audio or MIDI track to an audio instrument track by clicking on the 
track name, holding down the mouse button and choose Audio -> 
Audio Instrument -> Inst 1. 
 

 
 
Double click the audio instrument track to open the environment 
window. Logic scrolls automatically to the first instrument bus in the 
Logic mixer. 
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Choose the Kontakt Player 2 plug-in in the appropriate insert slot of 
the instrument track, either in the arrange or mixer window. To do 
so, click onto the insert slot, hold down the mouse button and 
choose Stereo -> Audio Units -> Native Instruments -> Kontakt 
Player 2. (Kontakt Player 2 can also be used as a multichannel 
instrument.) 
 

 
 
The plug-in now appears in the instrument slot and is ready to use. 
The instrument mixer channel will allow you to mix, pan, and process 
the software’s output just like any other existing audio track in Logic. 
 
If the Kontakt Player 2 interface is not already open, double click on 
the mixer’s insert slot to call up the Kontakt Player 2 interface. Here 
you can control and edit all the features and functions that the 
product has to offer. 
 
After loading an Instrument, you should be able to trigger it via MIDI 
using a keyboard controller. Kontakt Player 2's sound will generate 
through the mixer and directly to your sound card. If the plug-in does 
not receive MIDI or generate audio, then make sure to check the 
following two areas: 
 
Make sure the Instrument track is selected / record enabled in the 
Arrange window. 
 
The MIDI channel of your MIDI track must correspond to the receive 
channel of the loaded instrument. 
 
Make sure that you have properly configured your soundcard for use 
with Logic. 
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You may also want to refer to the Logic manual which offers 
additional instruction in using virtual instruments and plug-ins within a 
Logic project. 
 

MOTU Digital Performer 
 
Launch Digital Performer and create an instrument track by selecting 
Project -> Add Track -> Instrument Track -> Kontakt Player 2.  
 

 
 
Create a MIDI track by selecting Project -> Add Track -> MIDI Track. 
In Digital Performer's track overview window (or in the sequence 
editor window) assign the output of this MIDI track to Kontakt Player 
2 and a MIDI channel. 
 
The plug-in is now ready to use. The mixer of Digital Performer will 
allow you to mix, pan, and process Kontakt Player 2's output just like 
any other existing audio track.  
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To play Kontakt Player 2 with your keyboard, record-enable the MIDI 
track which you have routed to Kontakt Player 2 and make sure MIDI 
Patch Through is enabled in the Studio menu of Digital Performer. 
 
After having loaded an Instrument, you should be able to trigger it via 
MIDI using a keyboard controller. Kontakt Player 2's sound will 
generate through Digital Performer's mixer and directly to your sound 
card. If the plug-in does not receive MIDI or generate audio, then 
make sure to check the following areas: 
 
Make sure MIDI Patch Through is enabled in the Studio menu of 
Digital Performer. 
 
The MIDI channel of your MIDI track must correspond to the receive 
channel of the loaded instrument. 
 
Make sure that the instruments track output is correctly set. 
 
Make sure that you have properly configured your sound card for use 
with Digital Performer. 
 

Apple GarageBand 
 
Launch GarageBand. 
 
Press the “+” button to create a new “Software Instrument” Track. 
From here you can choose the icon you wish to use. 
 
Double-click the instrument track icon or press the “I” icon to get the 
Track Info. 
 
From the Info window expand the Details triangle underneath the 
Instrument icon to expose the track settings. 
 
From the Generator drop-down menu, choose Kontakt Player 2 from 
among the Audio Unit plug-ins. 
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Clicking on the pencil icon next to the “Manual” drop-down menu will 
open the Kontakt Player 2 interface for editing. 
 
Kontakt Player 2 can now be played using an external MIDI 
keyboard. 
 
Cakewalk Sonar 
 
Launch Sonar. In the synth rack choose Kontakt Player 2 DXi 2. 
 

 
 
Route a MIDI track to the DXi 2-Plug-in by selecting Kontakt Player 2 
in the Out drop down list. 
 

 
 



 

4 1 . . . . . . . . . . . . . . . . . . . A c o u s t i c  L e g e n d s  H D   

After having loaded an Instrument from the library you should be able 
to trigger it via MIDI using a keyboard controller. Kontakt Player 2's 
sound will generate through Sonar's mixer and directly to your sound 
card. If the plug-in does not receive MIDI or generate audio, then 
make sure to check the following areas: 
 
Make sure MIDI Patch Through is enabled in the Studio menu of 
Sonar. 
 
The MIDI channel of your MIDI track must correspond to the receive 
channel of the loaded instrument. 
 
Make sure that the instruments track output is correctly set. 
 
Make sure that you have properly configured your sound card for use 
with Sonar. 
 

Digidesign Pro Tools 
 
Launch Pro Tools. 
 
Create a new Instrument track by choosing New Track from the File 
menu. 
 
Locate the channel mixer Window -> Mix. 
 
The dark grey box at the topmost section of the Instrument channel 
is the RTAS insert section. Click on the first empty slot to show all 
available RTAS plug-ins.  
 
Choose Kontakt Player 2 from the multi-channel RTAS plug-in > 
Instrument menu 
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To open the plug-in interface for editing, click once on the insert slot. 
 
After having loaded an Instrument, you should be able to trigger it via 
MIDI using a keyboard controller. Kontakt Player 2's sound will 
generate through the mixer and directly to your sound card. If the 
plug-in does not receive MIDI or generate audio, then make sure to 
check the following areas: 
 
A physical input may need to be assigned to the instrument track. 
 
The Instrument track fader (Mix window) may be down. 
 
The instrument track in not selected in the Edit window. 
 

Using Kontakt Player 2 
 
Whether you use Kontakt Player 2 as a standalone application or as 
a plug-in, once you've set up its audio/MIDI options (in the 
standalone) or instantiated it as a plug-in and properly routed MIDI 
and audio to and from it, the program will behave identically with very 
few exceptions. 
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Browser 
 
On the left side of the screen is the Browser. The Browser gives you 
the capability to navigate through your available Kontakt Player 2 
libraries, as well as view engine information and assign automation. 
 

Libraries 
 
Using this tab, you will see all installed Kontakt Player 2 sound 
libraries. You can have an infinite amount of sound libraries installed 
here.  
 
In the submenu under the Libraries tab are a few buttons. There is a 
refresh button to refresh the Browser and an eject button to eject an 
optical disc. 
 
You will also see two dropdown menus for User Instruments and 
User Multis. Anytime you resave an instrument or a multi using the 
Load/Save menu, your saved instruments and multis will appear in 
this menu. (By default, they are stored on your hard drive inside the 
Kontakt Player 2 program folder/ User patches. Later in this manual, 
we will discuss the saving of instruments (in the Load/Save menu 
section). 
 

Library Box 
 
For each library, there is an Instruments, Multis, and Info tab. These 
three tabs allow you to navigate through the library. Instruments are 
the basic patches that are created for you to use. Multis are 
combinations of various instruments.  
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If you click on the Instruments or Multis button, all instruments or 
multis will be displayed below in the Browser.  
 
Multis can be merged with other multis; when loading a new multi, 
select “No” in the Replace Multi dialog box so that the existing multi 
is not replaced but merged with the new one; note that only the 
instruments of the new multi will be added to the end of your current 
multi, all other settings, e.g. outputs and master effects, are left 
unchanged. 
 
If you click on the arrows just to the right of either button, the 
contents of the library will appear in an easy-to-use hierarchical 
menu. 
 
The Info button brings up additional information about the library. 
 
About: Here you see important library information, such as the serial 
number and the library credits. Click the “Show Read-me” button to 
open the library read-me document. 
 
Update: Use this tab to check for available Library updates or 
crossgrade offers to other products. 
 
Register: All libraries must be registered to unlock them for 
continued use.  This tab provides a shortcut to the Native 
Instruments Service Center.  Click once to start the Service Center 
application.  Note that Service Center must be installed for this to 
work. 
 
Forum: This link connects you to the user forums of both the library 
developer and Native Instruments.   
 
Support: Click this link to be directed to the relevant Support pages 
for technical support.  
 
Library Installation path: Use this to set the install directory for 
your library.  This is especially necessary when you move your library, 
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either to another hard disk or to another location.  Please note that if 
you use your Kontakt Player 2 library exclusively in Kontakt 2, you 
must set the library path here in order for the library to continue 
working correctly. 
 

Note: Only libraries that are released for Kontakt Player 2 
(for example, Acoustic Legends HD, which you just 
purchased) can be loaded. Kontakt Player 2 is not able to 
load general Kontakt or Kontakt 2 patches, nor is it able to 
import libraries from foreign formats. To do these things, you 
must own the full version of Kontakt 2. 
 
The full version of Kontakt 2 offers other powerful benefits, 
such as more extensive editing, and the ability to use all 
Kontakt patches (whether user-created or released for 
Kontakt Player 2) and mix and match freely between the 
two, as well as import libraries in foreign formats. 

 

Engine 
 
Clicking on the Engine tab brings up various information about how 
the Kontakt engine is performing. This information is updated in real-
time, so you can watch exactly how it behaves under various 
conditions (e.g. high polyphony, high CPU loads, etc.) 
 

Automation 
 
The Automation tab allows you to assign various types of MIDI 
automation to various knobs within Kontakt Player 2. 
 
In standalone mode, choose MIDI Automation. 
 
When using Kontakt Player 2 as a plug-in, select Host Automation. 
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When in MIDI CC mode, move the MIDI device’s control that you 
want to use for parameter control in Kontakt Player 2. A “lightning 
bolt” will light in red to the left of the corresponding CC number in the 
browser. Click on the CC number and drag it on top of the 
parameter you want to control. A hand will appear if the assignment 
is  allowed. Release the mouse, and the assignment is made. 
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With Host Automation mode, select an unused ID and either double-
click or click on Set to perform the assignment. The automation 
always applies to an entire group. 
 
The only functions which can use with host automation are the 
volume, tune and pan knobs. The performance view knobs cannot 
be used with host automation. 
 

Note: Several parameters can be assigned to the 
same controller. This is great if you want a single 
control to do many things, such as increase 
brightness while increasing level. Also note that the 
Mod wheel is usually fixed at Controller 1, and 
Volume at Controller 7. 

 
Remove: To remove an automation assignment, select it then click 
on Remove. 
 
Smoothing: Incoming MIDI data is “quantized” to 128 divisions. 
Sweeping some parameters with this quantized signal produces a 
“stair-step” or “zipper” effect. The Smoothing parameter smoothes 
the incoming MIDI data (through a process of mathematical 
integration, just in case you wondered) by creating a ramp between 
values rather than a sudden jump. However, note that higher 
smoothing values also make the control less responsive when 
controlled over MIDI. 
 
Soft Takeover: Enabling Soft Takeover causes a parameter not to 
change until an external controller matches its existing value. 
Example: Suppose a level parameter is set to halfway, and a 
hardware control assigned to level is turned all the way down. 
Without Soft Takeover, as soon as move the hardware control the 
parameter will jump to the new value – in this case, something close 
to full off. With Soft Takeover, nothing will happen as you turn up the 
hardware control until the control is up halfway. It now matches the 
existing parameter value, which allows it to take over parameter 
control. 
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Cancel: So you didn’t really mean to assign that controller after all? 
Click on Cancel. 
 

Main Control Panel 
 
The Kontakt Player 2 main control panel gives you access to several 
controls and displays which are global to the program. 
 

 
 
The upper four buttons (Browser, Outputs, Keyboard, and 
MasterKontrol) toggle the visibility of these four areas of the program. 
 
Note: If you are using the standalone version of Kontakt Player 2, 
you can use the F1-F4 keys to toggle each of these buttons from the 
keyboard. 
 

Output Section 
 
When you click the Outputs button, the Outputs window appears at 
the bottom of the rack. 
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There are two types of faders: “Blue” faders that relate to channel 
outputs (the number of faders depends on the number of available 
outputs), and four “orange” faders that control return from the four 
send effects, as used in Multi setups. Each fader, output or aux 
return, has four effect insert points. 
 
Let’s cover output channel features, going from top to bottom. 
 
Add Channel: Adds another output channel to the Outputs section. 
 
Delete Channel: To delete a channel, click on any section of the 
channel that doesn’t contain an editable parameter; the channel 
becomes outlined in yellow. Click on Delete Channel to delete. Note: 
You cannot delete the Aux return channels. 
 
Hide Inserts: Hides all inserts to conserve space. 
 
Edit Effect: To edit an insert effect, click on it. Then click on this 
button to open and close the edit section for that effect. To delete an 
effect, click on the effect strip that includes the parameters (not the 
module in the slot); the effect strip becomes outlined in orange. 
Then, press the computer keyboard’s Delete key. 
 
Reset Out Map: This button can be used to restore the output 
mapping to the default settings. 
 
Make Default: Clicking on this button saves the current output 
mappings as your permanent defaults. (These output mappings are 
saved to the Kontakt Player 2 application directory inside the 
Defaults folder.) 
 
Name Fields: Each channel has a name field at the top. Double-
click in the field, and type in the desired name. 
 
Insert Effect Slots: To insert an effect, click on the downward 
arrow toward the right of the slot, and select the desired effect from 
the drop-down list. 
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Adjust Output or Aux Return Level: Move the appropriate fader. 
 
Config: This is where you configure the output for number of 
channels and channel assignments.  
 

 
 
When you click on a channel’s Config button, a dialog box appears 
with several fields. You can edit the Channel Name, but also, the 
number of audio channels (click on the Audio Channels parameter, 
then drag up or down). Note that you can’t specify more audio 
channels than actually exist. 
 
Each channel shows up in a list. Click on the channel’s Physical Out 
field, and a pop-up menu appears with all available output. Click on a 
physical output to assign it to a Kontakt 2 virtual output. 
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You can use the << and >> buttons in the lower left hand corner to 
automatically go to the next available output. 
 

Output Routing 
 
Note: There are only 16 mono outputs possible when Kontakt Player 
2 is used as an Audio Unit plug-in, even though  newer Logic 
versions support 32 outputs. Surround channels in Cubase are not 
supported. In addition to the methods mentioned below, different 
output configurations can also be saved as part of a multi. 
 
In stand-alone mode, there are 32 mono outputs possible. Therefore, 
the maximum number of supported physical mono outputs is 32. If 
your audio interface supports more than 32 mono outputs, you will 
only be able to use the first 32 outputs in Kontakt Player 2. Outputs 
can not be freely mapped on the physical level of your audio 
interface 
 
In plug-in mode, the maximum number of virtual mono outputs is 
always 32 for VST and DXi / 16 for AU and RTAS. For VST only, 
three default plug-in versions are available with 8, 16, and 32 outputs 
respectively. For all other plug-in formats, outputs are selected 
dynamically via the host (please check respective host 
documentation for details). If your host does not allow you to remove 
unused channels, these channels might still use CPU. Kontakt Player 
2 will automatically mute all unused channels and thus lower CPU 
usage within the Kontakt Player 2 engine. 
 

 
 
A default configuration is kept which is used as soon as Kontakt 
Player 2 is started. Kontakt Player 2 keeps a separate default config 
setting for every flavor of Kontakt Player 2; in other words, 
standalone, VST, AU, DXi, RTAS all have their own output 
configurations. In order to change the output config, you need to first 
organize the outputs the way you want and then click on the "make 
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default" button in the Output section. This ensures that at next 
startup the outputs are the way you set them. 
 
Another way to store and recall an output configuration is for plug-in 
use only – it is trickier and needs careful handling. The output 
configuration is also stored together with a plug-in’s total recall data, 
which means that a saved song will be recalled with the output 
config it was saved with. This means that a recalled song might 
contain a Kontakt Player 2 instance with outputs differing from the 
default configuration; or it might even contain several Kontakt Player 
2 instances using entirely different output configurations. This bears a 
lot of potential trouble and practically no host can effectively handle 
this situation. 
 
This is why Kontakt Player 2 has to declare its output requirements 
the first time an instance gets plugged in; this cannot be changed 
from that point on. The host thinks Kontakt Player 2 has only one 
output configuration, being the stored default config. This is why it is 
a good idea to stick to the default configuration and make every 
change in the default itself (by clicking on "make default"). When 
using Kontakt Player 2 as a plug-in in a sequencer, it's also advisable 
to unplug and then replug all instances after a fundamental change 
and / or reloading the song. 
 
"Reset Out Map" (reset output mapping) restores the output 
mapping to the default settings. Kontakt Player 2 allows you to freely 
map each of the output channels to the available physical outputs. 
The button automates this in a simple default way: all physical 
outputs are assigned to Kontakt Player 2's output channels until they 
are used up. Take for example the new 8-channel VST version; if the 
user has Kontakt Player 2 set up to use 2 stereo and 4 mono 
outputs, and he presses the make default button, then the 8 
available plug-in outs will be fully assigned to the available Kontakt 
Player 2’s output strips (1-2, 3-4, 5, 6, 7, 8). The aux channels, 
coming after the "normal" output channels, will receive no 
assignment in this example. On the other hand, if you Kontakt Player 
2 set up with just two stereo outputs, the other four available 
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physical outputs will be automatically assigned to the first two 
(stereo) Auxilliary Outputs. 
 

Keyboard 
 
The Keyboard button displays an onscreen keyboard which features 
tinted keys, which can be helpful in showing you which keys are 
active in any given instrument. Keys which have samples mapped on 
them are tinted blue, and keyswitch keys are tinted red. Keys which 
are being played will be shown in real time. 
 
You can transpose the keyboard's range within three octaves as well 
as create pitch bend and Modulation events (MIDI CC 1). 
 

 
 

MasterKontrol 
 

 
 
 
When enabled in the Main Control Panel, this sits right under that 
panel and provides a lot of useful functions. 
 
The tempo knob sets the tempo for tempo-synced effects. If Kontakt 
Player 2 is used within a host program, this displays the host’s 
tempo. The default is 120.00 BPM. There is also a sync button to 
sync to incoming tempo information (not visible in the standalone 
version). 
 
There are three ways to set tempo manually: 
 
Adjust the tempo knob. 
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Double-click on the tempo field and type in a new number. 
 
Tap a rhythm on the Tap button. Hint: This is also useful for finding 
out the tempo of a song if you don’t already know it. 
 
To use the Metronome, click the On button to enable it. The light 
below the on button flashes with the tempo, and the control varies 
the metronome volume. 
 
The Master Tune area defaults to A=440, but can be adjusted with 
the knob from A=392.00 to A=493.88. 
 
If you’ve used use a sample library where some of the notes are out 
of tune, you’re going to love this feature – you can set a reference 
pitch, and tune the sample against it. The reference tone can also be 
used for level setting within systems, or provide a reference tone for 
tuning guitar, bass, etc. 
 
Click on the Note Name field and drag up and down to select the 
reference pitch. Turn it on with the On button, and use the knob to 
set the reference tone level. 
Load/Save 
 
The Load/Save menu gives you options for loading and saving 
instrument and multis, as well as resetting the entire multi (i.e. 
clearing the rack.) 
 
Instruments and multis can be loaded using the Load option, and 
can also be loaded by simply dragging and dropping the NKI or NKM 
file from the desktop. 
 
Note that when saving instruments and multis, you are only saving 
the instrument/multi definition files, not the individual samples. Each 
individual sample is encrypted within the protected monolith file, and 
the raw samples cannot be extracted. In the Save dialog box, the 
patch + samples and monolith options are not available. This is due 
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to the copy protection of the library; the samples cannot be 
extracted nor resaved. 
 

 
 
There is an option to save the patch with absolute sample paths 
enabled or disabled. When you save with absolute paths enabled, 
the patch file includes a direct and absolute link to the location of the 
encoded samples on your hard drive. In other words, the absolute 
path will reference your hard drive name and the exact subfolders 
which the encoded samples are stored. This is the best option to use 
if you will not be sharing this library among multiple computers and 
intend not to move the location of the encoded samples. By doing 
this, every time you load one of the user patches, it will instantly and 
automatically find the samples. 
 
By disabling the absolute path option, a relative path is used instead. 
For example, if you save the instrument in a subfolder which sits 
alongside the encoded sample files, a relative path will read 
something like "go up one level in the folder hierarchy and you'll find 
the encoded samples there." Relative paths are the best option if you 
think you may move the samples around. Be sure that the relative 
location between the newly saved patch and the encoded samples 
stays the same in order to make sure the samples can always be 
found automatically. 
 
If a saved patch ever loses track of where its samples are stored, you 
will be presented with a dialog box upon load which prompts you to 
find the location of the samples. 
 
Instruments and multis saved from within Kontakt Player 2 are 
accessible through the Browser's User Instruments and User Multis 
menus, and can be used by anyone who owns the same library, 
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from within either Kontakt Player 2 or the full version of Kontakt 2. 
The instruments cannot be used by a user who does not own the 
same library. 
 

Options 
 
The Options menu is where you determine overall Kontakt Player 2 
preferences. Clicking on this button to open the Options window, 
which has five subcategories. 
Tab 1: Interface 
 
Here you make basic adjustments to Kontakt Player 2’s layout of 
Kontakt and functionality. 
 
Small Size/Mid Size/Big Size: The View menu lets you choose one 
of three sizes for Kontakt Player 2: Small, Mid, and Big. The edit 
boxes let you specify the size, in pixels, for the size. The width and 
height have separate fields; to change a field, double-click on it and 
enter the new value. Note: The new value will take effect the next 
time you open Kontakt Player 2. 
 
Capture Keyboard from Host: Enabling this button catches certain 
keyboard keys and routes them to Kontakt Player 2 rather than to 
the host program. For example, you may want to type certain things 
on the keyboard and have them affect Kontakt Player 2 but have no 
effect on the host (e.g. you want to name something in Kontakt 
Player 2 using a letter that happens to be a keyboard shortcut for the 
host). Enabling this ensures the keystroke is interpreted by Kontakt 
Player but not the host.  
 
Capture Mouse from Host: This is similar to Capture Keyboard 
from Host, but directs Mouse Wheel movements to Kontakt Player 2 
instead of the host. 
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Show Mapping and Keyswitches on Keyboard: This button 
shades keys on the “virtual master keyboard” (along the lower part of 
the window) to indicate mapping and keyswitching. 
 
Auto-refresh Browser: This option activates the auto updating of 
the browser. When activated, the browser automatically detects from 
the operating system if a folder is changed / created. 
 
Menu Font Size: This drop-down list allows setting the font size 
bigger for increased legibility, or smaller to fit more items on screen. 
 
Tab 2: Audio Engine 
 
These settings affect Kontakt Player 2's audio engine. 
 
Default Volume for New Instruments and Volume Reset: 
Choose between –6dB and 0dB. 
 
CPU Overload Protection: This function will kill voices if the CPU 
load gets too high. You can specify how tolerant you want the engine 
to be. 
 
Multiprocessor Support: Enable this checkbox if you have a 
computer with more than one processor to take advantage of the 
additional CPU power. 
 
Send MIDI to outside world: 
 
*GUI keyboard: Virtual keyboard / Mapping Editor keyboard / 
computer keyboard events 
 
*Script generated CCs: script controller events like CCs, RPNs, 
NRPNs 
 
*Script generated notes: script note events (when enabled, this 
setting might create duplicate notes when recording in your host) 
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Offline Interpolation Quality: The new HQI mode allows you to 
select among three quality options when bouncing audio from within 
a host. “Standard” corresponds to the old mode, whereas “High” 
and “Perfect” increase the quality. HQI mode helps you eliminate 
digital aliasing sounds which become particularly audible when you 
transpose sounds with significant high frequency content upwards. 
Note that this quality comes with a price in the form of additional 
CPU load and thus a lower total voice count. 
 
Important: Both modes “high” and “perfect” will use more cpu if the 
transposition is higher. E.g. if you transpose a sample one octave, 
then 2 octaves, the cpu load will double every octave. So if you 
transpose your sample many octaves higher, the cpu load might be 
very high. 
 
Open Audio and MIDI Settings: Click on this button to view audio 
and MIDI settings that relate to your audio interface. 
 
Tab 3: Handling 
 
Use Computer Keyboard for MIDI Playback: This lets you use 
your computer keyboard to trigger Kontakt Player 2 (handy for laptop 
jockeys on airplanes!). You can also edit the Velocity value that a key 
will trigger. 
 
Keyboard Velocity: This specifies what velocity should be sent 
when using the computer keyboard for MIDI playback. 
 
Solo Mode: Choose between Solo In-Place (only one instrument 
can be soloed, others will be muted) and Solo Latch (you can switch 
several instruments into solo mode). 
 
Browser: Double-Click Loads Instrument: If enabled, double-clicking 
on a Sample in the Browser creates a new Instrument, with the 
sample spanning the entire keyboard range. If you Shift-Click multiple 
samples and double-click on the group of Samples, this not only 
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creates a new Instrument, but also auto-maps the samples equally 
across the keyboard. 
 
Browser: Show Files Before Folders: This alters the sorting 
algorithm of the Browser to show files before folders. 
 
Default Root Key for New Zones: Samples without root key 
information will default to this as their root key. 
 
MIDI Channel Assignment for Loaded Patches: This menu tells 
Kontakt Player 2 what MIDI channel you want newly loaded 
instruments to be assigned to. "1st Free" loads up each subsequent 
instrument on the first unused MIDI channel. "Omni" assigns all 
instruments to OMNI (meaning they will receive MIDI on any incoming 
channel). "Keep channels from K 1.x Patches" will allow the patches 
to load with whatever MIDI channels were saved within older Kontakt 
1 patches. 
 
Installation Base Path: If you change the name of the Kontakt 
Player 2 folder, certain presets might not be available anymore. Set 
the installation path here to the location of the Kontakt Player 2 
folder. 
 
Tab 4: Load/Import 
 
Load Instruments/Banks/Multis in “Purged Mode” (Without 
Loading Samples into RAM): Reloads the parameters of Samples 
that were purged, but without the Sample data itself. See Purge 
Menu below. 
 
Force-load Pre-2.0 Patches in DFD Mode: This forces the engine 
to use DFD streaming even for old patches that were not originally 
saved with it. 
 
Unwind Automation ID's for Additionally Loaded Patches: This 
is a very useful option when assigning host automation IDs to a 
patch and then loading the same patch in several slots; just imagine 
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that you assign host automation IDs #0 to #9 to a patch to control 
typical synth features; now if you load the patch into Kontakt rack 
slots 3 and 7 in your song you would want to select different LFO 
settings for the two slots; this is now possible with this new feature 
because the second instance of your patch now gets host IDs #10 to 
#19 instead! 
 
Library Path: This is the “User Patches” save location. Here you can 
save User tweaked instruments and combination multis (from many 
libraries). By default it is set to the Kontakt 2 Application folder. If you  
move that folder to another location, use this option to reset the 
“User Patches” path. 
 
Tab 5: Search/DB 
 
This screen gives you options to specify what folders or volumes 
should be used when using search functions. 
 
Tab 6: DFD - Direct from Disk 
 
Amount of Memory for DFD: Adjusts the amount of RAM to 
dedicate to the DFD process. Although samples stream from disk, it 
is necessary to store attacks in RAM so they are available instantly 
upon playback. If DFD isn’t working properly, try allocating more 
RAM to this function. 
Purge Menu 
 
Purge analyzes which samples were used in an arrangement, and 
removes from RAM any samples that weren’t used. Thus, Kontakt 
Player 2 can handle huge amounts of samples while exhibiting very 
low RAM usage. Scoring of large ensembles with many instruments 
and samples now becomes manageable. 
 
Purge is available here on a Global level, but is also available on the 
Instrument level. You would use Global purge after a song was done, 
and you wanted to remove all unneeded samples. The Instrument 
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purge is handy if you’ve finished a part; you can purge samples for 
that Instrument alone, thus freeing up RAM for additional overdubs. 
 
Click on the downward arrow to access the following functions. 
 
Reset Markers: Deletes all “tags” that mark samples as used. 
Update Sample Pool: Unloads unused Samples from RAM, and 
loads newly marked Samples in RAM. 
Purge All Samples: Unloads all Samples from RAM. 
Reload All Samples: Reloads all Samples used in an Instrument. 
Load Everything Purged (Without Samples): Reloads the 
parameters of Samples that were purged, but without the Sample 
data itself. 
 
A display for the instrument shows Purge status. 
 
Green: All Samples are loaded. 
Orange: Samples have been purged to reduce RAM requirements. 
Red: Empty – all Samples are unloaded from RAM. 
View Menu 
 
The entire instrument can be re-sized from the View menu. Choices 
are Normal, Bigger, and Large. Typically you will use Large when 
creating Instruments, and Normal when everything has been 
programmed, and you’re using Kontakt Player 2 as a plug-in or 
stand-alone device. You can set the window size under Options > 
Interface.  
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System Performance Meters 
 
These are located in the upper right section of the Main Control 
Panel. 
 

 
 
Clockwise from upper left, these show the following. 
 
Notes: The amount of polyphony being used. The first digit shows 
the current number of notes being played; the second digit shows 
the maximum amount of polyphony. 
 
CPU: Shows how much CPU power is being used by Kontakt Player 
2. More bars indicate more CPU use. 
 
Disk: Shows the amount of Kontakt Player 2’s hard disk access. 
Pulling more data from disk illuminates more bars. 
 
RAM: Indicates how much memory is being taken up by the 
samples used by Kontakt Player 2. This figure will be much higher if 
DFD is not being used. 
 
Minimized Player View 
 
The last button on the right (next to the NI logo) is for Instrument 
Focus view. 
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Clicking on this button will instantly zoom into the currently selected 
instrument, and will hide all other areas of the Kontakt Player 2 
interface (e.g. Browser). This can be a useful tool to instantly collapse 
the Kontakt 2 Player screen to its smallest size and most essential 
elements. 
 
About Kontakt Player 2 
 
An About screen can be accessed by clicking either the Kontakt 
Player 2 logo in the far upper left corner of the interface, or the NI 
logo in the far upper right corner. The About screen contains the 
specific version numbers of all components of the Kontakt Player 2 
installation, as well as design credits and links to web pages 
containing updates, support, and more. 
Multi Area 
 
The Multi area is the large area on the right side of the Kontakt Player 
2. Also referred to as the rack, this is where all loaded Kontakt 
Player 2 instruments reside. You can load multis (which are 
combinations of instruments) or you can load individual instruments, 
and they will both appear here. 
 
Instruments can be reordered in the rack within the same multi page. 
This works via drag-and-drop. When loading new instruments, these 
might still appear in between the already loaded instruments and not 
at the bottom of the rack. 
 
There are a few buttons in the upper right hand corner that allow you 
to work with the rack. 
 

 
 
The four numerical buttons allow you to switch between four different 
pages of the rack. By using these, it's possible to load up to 64 
different instruments at once. 
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The Aux button is a toggle switch to show or hide the aux send 
faders for each instrument. 
 

 
 
Instrument views 
 
Performance View 
 
The performance view shows a custom panel which allows you to 
alter specific characteristics of the instrument. You can view this 
panel by clicking on the icon immediately below the gear icon in the 
upper left hand corner. 
 
Consult the Acoustic Legends HD Manual for extensive information 
on the available controls. 
 
Minimized and Maximized View 
 
The instrument minimize and maximize buttons allow you to instantly 
collapse or expand every instrument in the rack to its minimized or 
maximized view, respectively. The maximized view is useful when 
editing an instrument and accessing its panel. The minimized view is 
useful when you want to view all your instruments at once. 
 
An instrument in minimized view shows only its name, solo and mute 
buttons, volume, pan, and tune knobs, and meters. The X button in 
the upper right corner deletes the instrument, and the + button 
switches to performance view. 
 

 
 
Instrument maximized view is also available. An instrument in 
maximized view shows additional details about the instrument, such 
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as output settings, MIDI channel, polyphony, a memory meter, and 
the purge. 
 
Kontakt Player 2 supports up to 64 MIDI input channels (4 ports with 
16 channels each); only the stand-alone version supports 4 MIDI in 
ports; your physical MIDI in ports that are marked as active in the 
Audio Setup dialog's MIDI tab are assigned to ports A - D 
automatically; in the plug-ins, only port A is active. 
 
 

 
 
Clicking on the gear icon itself brings up the Instrument Options 
window, which will be discussed below. 
 

Instrument Options 
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Instrument Tab 
 
Voice Stealing Mode: Choose from the following. 
 

Kill Any (the algorithm decides which is the best 
one to steal) 
Kill Oldest (oldest note still sounding) 
Kill Newest (most recently played note) 
Kill Highest (highest-pitched note) 
Kill Lowest (lowest-pitched note) 

 
Voice Stealing Fadeout Time: Sets how long a stolen voice will 
fade out before it disappears, from 0 to 1000ms. This may cause the 
number of voices to temporarily exceed what’s specified as the 
maximum amount of polyphony. 
 
Key Switch Default Key: This is the first key that is activated when 
you load this instrument with “Start on key” group start options. 
 
MIDI Transpose: Transposes incoming MIDI data in semitones. 
Example: If this is set to 2 and you play a C# on your keyboard, the 
Instrument being triggered will play a D#. 
 
Key Range: This sets the Instrument’s keyboard range. Placing your 
mouse over the lower or upper limit causes a double arrow to 
appear. Drag up to raise the limit’s note pitch, or drag down to 
lower. The range cannot go below C-2, or above G8. Use this with 
multiple Instruments to create keyboard splits - for example, bass 
could cover the lower two octaves of your keyboard, and piano the 
rest. Double-click the a value field to enter a note from your 
computer keyboard. 
 
Velocity Range: This restricts the velocity range to which an 
Instrument will respond. Placing your mouse over the lower or upper 
limit causes a double arrow to appear. Drag up to raise the velocity 
limit, or drag down to lower. The range cannot go below 1, or above 
127. Double-click a value field to enter a value from your computer 
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keyboard. Example: You could set a B3-type organ Instrument to 
respond to velocities 1-127, while a pipe organ Instrument responds 
to velocities 111-127. Velocities of 111 or above will layer the two 
organ sounds for a more powerful effect. 
 
DFD & Load Tab 
 
DFD Preload Buffer Size: Sets the amount of RAM dedicated to 
each preload buffer when using DFD. This is an expert setting and 
should not be adjusted unless you are instructed to do so from tech 
support. You have been warned! 
 
Controller Tab 
 
MIDI Controller #64: This drop-down menu determines how 
Kontakt Player 2 responds to MIDI Controller #64, which defaults to 
controlling the sustain pedal. Here are your options. 
 
Sustain Pedal and Controller: Kontakt Player 2 will respond to a 
switched (on-off) or continuous controller (values above 64 = sustain 
on, values 64 or under = sustain off). 
 
Sustain Pedal without Controller: Kontakt Player 2 will recognize 
only a switched controller. 
 
Controller Only: Kontakt Player 2 will recognize only a continuous 
controller. 
 
Accept All Notes Off/All Sounds Off: This option will filter All 
Notes Off and All Sounds Off messages, which some older 
controllers send by default. 
 
Accept Standard Controllers for Volume and Pan: This option 
will automatically cause each instrument to automatically respond to 
CC#7 for volume and CC#10 for pan. 
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MIDI Controller #7 (Volume) Range: Using this dropdown menu, 
you can adjust the minimum and maximum values that incoming 
MIDI CC#7 will translate to when controlling the volume of an 
instrument. 
Info Tab 
 
Instrument Icon: Choose an Instrument’s identifying icon. 
 
Instrument Info: A notepad for the Instrument, possibly including 
copyright information, helpful tips, etc. 
Instrument Categories: Choose an Instrument category. Being 
able to search on this can help considerably with database searches. 
Author: Information on the sample’s creator. This is limited to 8 
characters, so longer descriptions can go in the Info box. 
Weblink: Provides a web link to the author’s web site. 
 

Troubleshooting  
 
If something doesn't seem to work correctly, there must be a logical 
reason for it. Native Instruments software is tested on a variety of 
computers and configurations to ensure proper function. Having said 
that, there remain an infinite number of possible setups and within 
them any number of compatibility issues, software conflicts, 
hardware problems and so on. 
 
Below you will find some tips in regards to troubleshooting common 
problems with Kontakt Player 2. This list is by no means exhaustive. 
For more product specific issues please consult the product 
handbook, the Native Instruments Support Knowledge Base, or 
Native Instruments Technical Support. 
Standalone 
 
Library doesn’t find samples: 
 
This dialog opens when the loaded instruments cannot find the 
associated samples. In most cases the reason is because the Library 
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Installation path has been changed, as in the case when you expand 
your library storage and move your libraries to a new, bigger disk.  In 
this example, reset the library installation path using the Library box 
Info button. 
 
If you have this option correctly set and continue to get this error, 
then please use the option which best suits your needs. 
 
Sample Search Dialog (“Samples Missing”) with Spotlight 
Support 
 
The Sample Search / Samples Missing dialog appears when sample 
paths have been changed for whatever reason – for example, you 
have moved sample files to a different place on your hard disk – and 
Kontakt asks for your advice on how best to find them. Here is a 
quick run-down of the current options: 
 
Search File System: Look for samples in the volumes / folders that 
you have specified in the new Search / DB tab in the Options dialog 
(see below) 
Search Spotlight: On OSX 10.4 (Tiger) and higher, you can now 
use the native Spotlight search to find samples in an instant! 
Check for Duplicates: The new option works with any of the above 
actions; just consider that you have the 16 and 24 bit version of 
piano samples with the same name on your system; if you check this 
option, you will be presented with a choice of either the 16 bit or the 
24 bit sample folder 
Browser for Folder: Look for samples in the folder of your choice 
(including all subfolders) 
Browse for Files: Look for a specific sample file; use the Resolve All 
Possible option to look for other samples in the folder of the selected 
file 
Skip Missing: Load the patch only with the samples found so far 
and ignore any missing samples 
Abort Loading: Cancel the whole loading process 
 
Kontakt Player 2 won’t start (or crashes upon start): 



 

 A c o u s t i c  L e g e n d s  H D . . . . . . . . . . . . . . . . . . 7 0  

 
Check the system requirements for the Kontakt Player product which 
you want to use. The minimum requirements are the very least you 
can get by with, and are often not enough for larger projects. If your 
project calls for more instruments, more plug-in instances, etc. 
updating your RAM may save you a lot of trouble. 
 
Make sure you have the most recent Kontakt Player 2 version. 
 
Make sure that you have not clicked on an outdated application 
alias/shortcut. 
 
Try to restart your computer. Disconnect any audio interfaces and 
computer peripherals like printers, scanners and the like. 
 
My soundcard / MIDI device is not recognized: 
 
Quit all open applications. 
 
Disconnect and reconnect the device. Try another USB / Firewire 
port if one is available. Connect the device directly to the computer 
and not via a USB / Firewire hub. 
 
Open Audio MIDI Setup (Mac OS X) and see if the device shows up 
there. Test the MIDI setup for MIDI received. 
 
Update any soundcard / MIDI drivers from the manufacturer’s 
website. 
 
Deinstall and reinstall your soundcard / MIDI drivers. 
 
I don't hear any sound: 
 
Without being too product specific, there are usually two reasons for 
this problem. It is either MIDI or soundcard/routing related. 
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Make sure that the Kontakt Player MIDI channel is set to receive from 
your MIDI device properly. They must be on the same MIDI channel. 
If in doubt, set the Kontakt Player to OMNI. 
 
Output routing is incorrectly setup. Open the Kontakt Player Audio 
MIDI Setup / Routing tab and set the outputs to correspond to your 
soundcard's monitor (Main) outputs. 
 
Incorrect soundcard selected. Open the Audio/MIDI Setup dialog and 
choose the correct output device. 
 
The sound is distorted, playback drops out: 
 
Your latency settings are too low. Low soundcard buffers (low 
latency settings) strain your CPU more, so it may be helpful to 
increase the buffer size via your ASIO control panel; or in a host, the 
soundcard setup. For standalone, open the Audio MIDI Setup dialog 
and move the output latency to the right until you don’t hear any 
more distortion or playback is normal. 
 
Your CPU may be overloading. Kontakt Player 2 CPU meter to give 
you a quick look at what processing power is being used. If things 
here look normal, then your computer may have another process 
which is using resources needed for real-time audio processing. (PC) 
Check the Task Manager (ctrl-alt-delete) or (Mac) Activity Monitor 
(Applications/Utilities) and quit any processes which are using 
valuable CPU. Usually it is a good idea to deactivate virus scan 
software when working with audio.  
 
I hear a noticeable latency: 
 
The output latency is too high. Open the Audio/MIDI Setup dialog 
and move the output latency slider to the left.  
 
For PC users: Please note that some soundcards may not be able to 
achieve a comfortable latency. If this is the case you may want to to 
try the generic ASIO4ALL driver.  
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If you are using Kontakt Player 2 as a plug-in, check the host's 
hardware configuration and try a lower buffer size. 
 
The Kontakt Player 2 plug-in does not show up in my 
sequencer: 
 
Before checking the following options, please make sure that the 
latest NI product updates are installed. 
 
Cubase/Nuendo: From the Devices menu, open the plug-in 
information dialog. Make sure that the installed plug-in can be seen. 
Click the checkbox next to the plug-in name to activate it. Restart 
Cubase or Nuendo to have the changes take effect. 
Logic: Make sure that the plug-in was installed. Check the local 
plug-ins folder (Macintosh HD/Library/Audio/Plug-ins/Components) 
for installed items. Start the Logic AU Manager from the Logic 
Menu/Preferences. Rescan Kontakt Player 2, or reset and rescan all 
plug-ins. Even after scanning, you may need to activate a plug-in by 
clicking the checkbox next to it.  
Digital Performer: Rescanning all the plug-ins usually helps. To 
force Digital Performer to rescan all plug-ins, you should delete the 
preference file AudioUnit info cache from the folder: Macintosh 
HD/Users/~/Library/Preferences/Digital Performer 
 
The plug-in makes no sound: 
 
Try the software's virtual keyboard (if applicable) to see if the problem 
is MIDI related. Also set the plug-in MIDI channel to OMNI (when 
applicable). 
 
Cubase/Nuendo: MIDI track output not assigned to plug-in. 
Logic: Instrument Track not record enabled 
Digital Performer: MIDI track Output not assigned to plug-in, MIDI, 
Track is not record enabled, MIDI Patch Through not active from the 
Setup menu. 
Pro Tools: Physical Input not assigned to Instrument track 
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Application Install Error:  
 
If you receive this error, then something has gone wrong with the 
software installation. Your only choice at this point is to reinstall the 
software. Before doing so, back up any important files.  
 
PC: use the add/remove programs software in the Windows control 
panel to remove the software and all components. In case the 
program does not show up please use the uninstaller (UNWISE.EXE) 
located in the application folder (i.e. C:\Program Files\Native 
Instruments\Program name\ ) 
 
Mac: Delete the Application folder and any preference (plist) files 
before reinstalling. Plist files are located in  
 
MAC HD/Library/Preferences 
~ /Library/Preferences (where ~ is your home folder) 
 
Error Creating Folder / Access Denied: If you receive this error 
upon installation of any NI product on Mac, then it is likely there is a 
permission problem. The solution is beyond the scope of this guide, 
but the following link may help: 
 
http://www.nativeinstruments.de/index.php?id=niosxtut_us 
 

http://www.nativeinstruments.de/index.php?id=niosxtut_us
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Contact 
 
Vir2 Instruments 
29033 Avenue Sherman, Suite 201 
Valencia, CA  91355 
USA 
 
www.vir2.com 
support@vir2.com 
 
Copyright © 2006 Vir2 Instruments, a division of Big Fish Audio, Inc.  
All rights reserved. 
 
Vir2 Instruments, the Vir2 Instruments logo, and Big Fish Audio are 
registered trademarks of Big Fish Audio, Inc. in the United States 
and/or other countries.  Kontakt Player, Kontakt, Native Instruments, 
and their respective logos are registered trademarks of Native 
Instruments Software Synthesis, GmbH in the Germany, the United 
States and/or other countries.  Other marks are the properties of 
their respective owners. 
 
This computer program and instrument library is protected by 
copyright law and international treaties. Unauthorized reproduction or 
distribution of this program, or any portion of it, may result in severe 
civil and criminal penalties, and will be prosecuted to the maximum 
extent possible under the law. 
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